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Overview 

This guide provides an overview of the base reports available in StateFleet Online that will 

assist the Fleet Officer in the daily running of the motor vehicle fleet. 

 

It is recommended that the Fleet Officer follow the procedures outlined in this guide on a 

monthly basis, as a minimum requirement, to ensure the effective operation of the local 

fleet. 

 

This document does not provide information on fleet management.      

 

Reports featured by function include: 

 

Vehicle Acquisition  Vehicles Due for Replacement 

    Vehicles on Order 

 

Vehicle Disposal  Vehicles Due for Return 

    Replaced Vehicles not Returned 

 

Vehicle Maintenance  Vehicles Due for Service 

 

Fuel Usage   Fuel Consumption 

    Over Tank Capacity Report 

 

Vehicle Usage   Vehicle Utilisation by Kilometre 

 

For advanced information and training on StateFleet Online contact your StateFleet Account Manager.  
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Getting Started 

1. Go to StateFleet’s website www.statefleet.nsw.gov.au 

2. Select “Enter easyAccess” on the home page 

 

3. Select “StateFleet Online” in the myLinks menu 

 

4. Enter your User name and Password and Log On. 
 

 

 

5. You will now be able to view the StateFleet Welcome Page. 

 

If you do not have a User name 
or Password contact your Agency 

Fleet Manager or StateFleet 
Account Manager. 

  



 

A division of the Department of Finance & Services 5 
 

StateFleet Online User Guide 

My Work 

 

The My Work Page gives an overview of vehicles or leases that require your immediate 

action. Each icon lists the number of: 

• Vehicles Currently on Order 
 

• Vehicles Due for Service 
Vehicles due for service either by age or kilometres travelled 
 

• Vehicles Due for Replacement  
Vehicles that are nearing the lease end without a replacement order submitted to 
StateFleet 
 

• Vehicles with High Fuel Consumption 
Vehicles that are over or under the manufacturer’s specification for expected fuel 
consumption 
 

•  Vehicles Due for Return 
Vehicles within one month of their lease end or overdue 
 

• Replacements Not Returned 
Vehicles retained where a replacement has been delivered 
 

• Vehicle Utilisation by Kilometre 
Vehicles over or under utilised 
 

• Vehicles Sold in the Last Month 
Vehicles sent to auction and sold within the last month. 
 

Click on one of the icons shown to drill down to the vehicle level report. For a detailed 

explanation regarding reports please see the Report Features section. 
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My Fleet 

 

The My Fleet page provides access to reports on the current status of your Fleet. 

Using the icons listed through My Fleet you can access: 

• Fleet Reports 

Includes 
 

- Fleet List 
Active vehicles 
 

- Plant List 
Active plant items 
 

- Rent Card List 
Active rent card List 
 

- Fleet Mix 
Fleet profile broken down by key reporting areas 
 

- Vehicles on Order 
Current vehicle orders 
 

- Vehicles Delivered 
Vehicles delivered in the previous 4 weeks 
 

- Vehicles Due for Replacement 
Vehicles nearing the lease end without a replacement order submitted to 
StateFleet 
 

 

 

• Fuel Reports 
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Includes 
 

- Fuel Transaction Data 
All recorded fuel transactions for the last 2 months 
 

- Fuel Consumption 
All vehicles that are under or over the manufacturer’s specification for 
expected fuel consumption 

 

• Service Reports 

Includes 
 

- Vehicles Due for Service 
Vehicles due for service either by age or kilometres travelled 
 

• Finance Reports 

Includes 
 

- Total Fleets Costs 
Total fleet costs (as invoiced) for each successive month over the current 
financial year 
 

• Log Reports 

Includes 
 

- Vehicle Utilisation by Kilometre 
Vehicle utilisation to identify potential vehicles suitable for rotation to meet 
km requirements and avoid excess kilometre charges 
 

- Log Exceptions 
Vehicle entries from easy.Log 

 

• Safety Reports 

Includes 
 

- EPS and Safety 
Average environmental and safety scores of all live vehicles 

 

• Disposal Reports 

Includes 
 

- Vehicles Sold 
Vehicles sent to auction and sold within the last month 
 

- Vehicles Due for Return 
Vehicles within one month of their Lease End and Vehicles overdue 
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- Replaced Vehicles not Returned 

Vehicles that have had a replacement delivered but have not been sent to 
auction 
 

- Written Off Vehicles 
All vehicles that have been written off within the previous 6 months 
 

- Written Off Vehicles with Replacement details 
All vehicles that have been written off with replacement details 
 

Click on one of the icons shown to drill down to the vehicle level report. For a detailed 

explanation regarding reports please see the Report Features section. 
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My Reports 

 

 

The My Reports page provides access to a range of reports where you nominate the period 

criteria 

Using the icons listed through My Reports you can access: 

• My Fleet Reports 

Includes 
 

- MY – Fleet List 
Fleet list as at nominated date 
 

- MY –  Fleet Reports 
Fleet mix at nominated month/year, fleet list as at nominated date 
 

- MY – Vehicles Delivered 
Vehicles delivered within nominated period 
 

- MY – Due for Replacement within a period 
Vehicles due for replacement within a nominated period 
 

- MY – Due for Return within a period 
Vehicles within a nominated period of their lease end date 
 

• My Fuel Reports 

Includes 

- MY – Fuel Consumption 
Vehicles that are over or under the manufacturer’s specification for expected 
fuel consumption for the selected period. 
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- MY – Fuel Transaction 
All recorded fuel transactions for the selected month 
 

• My Service Reports 

Includes 
 

- MY – Vehicles Due for Service 
Vehicles due for service before the specified date 
 

• My Disposal Reports 

Includes 
 

- MY – Vehicles Sold 
Vehicles sold within a specified period 
 

- MY -  Written off Vehicles 
Vehicles written off in the previous 6 months 

 

Click on one of the icons shown to drill down to the vehicle level report. For a detailed 

explanation regarding reports please see the Report Features section. 
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My Folder 

 

You can use the My Folder page to access reports you have modified and saved. 

To access a saved report; 

1. Select My Folder from the menu  

2. Select the report from the list that appears. 

Note: If you have just saved the report and My Folder was already open you may need 

go out of the My Folder directory and go back in to refresh. 

 

For details on how to modify and save reports please refer to the Report Features 

section. 
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My Vehicles 

 

My Vehicles page provides information on individual vehicles and leases including 

transaction and financial history. 

1. Select the My Vehicles screen.  The vehicle listing will default to:  

- Status:    Active 

- Ownership:  Leased 

- Category/Group: Passenger/Commercial/Light Commercial 

 

You may change the default setting and Refresh List to suit your requirements 

 

2. Select the vehicle of interest by either: 

a. typing the registration number in the open field 

b. typing the last 7 digits of the VIN/Chassis number 

c. typing the contract number (excluding the slash and following 
digit) 

d. using the down arrow to scroll down and select the registration 
number. 

 

3. Select Run Report. 
 

4. Familiarise yourself with the information available by selecting each of the Tabs 
including details, accessories, fuel, logs, maintenance, financial and 
running costs.  
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My Fleet Builder 

 

The Fleet Builder allows you to restrict the number of vehicles that appear in reports and 

your Vehicle Details screen by applying a filter based on the level at which your User ID is 

set and the levels below. 

For example, if you have access at Division level, you can restrict your access to a 

particular region, or further to the bottom level Sub Cost Centre. 

 

To apply a Filter 

1. Open the My Fleet Builder page 

2. Select the applicable level using the cascading parameters in order from highest to 

lowest. 

3. Select Run 

 

To remove a Filter 

1. Select the My Fleet Builder page 

2. Select Remove Filter 

 

Note: Logging out of the system will not remove a filter. If you have applied a filter it 

will remain until you remove the filter using the Fleet Builder. 



 

A division of the Department of Finance & Services 14 
 

StateFleet Online User Guide 

Report Search 

 

If you experience difficulty navigating the portal and finding the report you are after, there is 

a search function you can use. 

 

To Search for a Report 

1. Click the Search Link at the top right of the portal 

 

 

2. Type a keyword in the Keyword field (for example, if you are looking for reports 

related to fuel, type fuel) 

3. Tick the SAS report tickbox. 

4. Press Search 

This will bring up a list of all reports that include the keyword. 
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Report Features 

StateFleet Online also has a range of inbuilt features designed to provide flexibility in the 

reporting of information to suit your own requirements. 

The following functions are available on all reports. 

Table of Contents 

When you open a report, at the left hand side of the screen 

you will see the Table of Contents. This will show you which 

sections are included within the report group.  

For example, if you open the Fleet Reports you will see the 

dropdown in the Table of Contents has seven sections. 

You will also see any Group Breaks set for the report you 

are currently viewing.  

Group Breaks are the value by which the report is divided. For example, in the illustration 

above, the report is split by the Vehicle Category Data Item and each value within the 

Vehicle Category field in the report is listed (Commercial, Light Commercial and 

Passenger).  

Section Data 

At the bottom left corner of each report is the Section 

Data. This lists all the available Data Items you can add 

to the current report. 

You will notice that the fields listed will have one of two 

icons on the left. 

 << This indicates a measure 

 << This indicates a category 

Moving Between Grouped Reports 

If you wish to view one of the other reports within the group, there are two options available. 

a) Select the report you would like to view from the Table of Contents dropdown or 

Group Breaks 

Report Sections 
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b) Enter the report number in the available field in the top right corner. 

The report number refers to the number of the row the report 

appears in the Table of Contents drop down box.  

Adding and Removing Data Items to a Report 

To add a Data Item shown in Section Data to the Report, 

1. Select the field you would like to add 

2. Drag the field to the report. You will see blue lines appear 

between the column headings that are already included. 

3. Drop the field between the headings of the two columns you 

would like the field to sit. 

To Remove a Data Item from the Report, 

1. Right click the heading of the Data Item column you would 

like to remove. 

2. Select “Hide [data item name]” 

Sorting a Report 

If the report is not sorted in the order that you require, you can adjust this. 

To sort by one column 

1. Right click the heading of the column you 

wish to sort by 

2. From the dropdown that appears, select 

Sort Ascending or Sort Descending 

To sort by more than one column 

1. Right click the report table 

2. From the dropdown that appears, select 

Sort Priority 

3. In the window that appears, select the 

columns you would like to sort by in the 

order you would like the report to sort. 

4. Select OK  
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Adding and Removing Group Breaks 

If you would like to add Group Breaks in your report 

1. Select the Edit Tab at the top of the 

report 

2. Select the Options in the Table of 

Contents and then select Group Breaks  

3. Using the drop down boxes provided, 

select the field you would like the report 

to be separated by (note that any 

measure items will not appear in the list) 

4. Select OK 

 

Should you wish the tables to appear on the 

same screen, you can un-tick “New page for 

each value”. 

 

To remove a Group Break, follow the same procedure to reach the Group Breaks window 

(right) and change the drop down boxes to None. 

Exporting a Table 

If you only require the data in the table of the report and do not require formats or the 

header and footer provided, 

1. Right Click anywhere on the table other than the Data 

Item column headings 

2. From the list that appears select Export Table  

3. In the Export window that appears you can select the 

number of rows to export and the columns you would 

like to export. 

4. You can either export the data to Microsoft Excel or 
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Microsoft Word, or save as a Tab separated 

values (.tsv) file or a Comma separated 

values (.csv) file. 

5. Once you have made your selections select 

OK.  

 

Exporting a Report 

If you would like to export the entire report including the formatting, StateFleet logo etc. 

rather than the table of data, 

1. Select the Import button from the top left 

hand menu (can also be accessed from the 

File menu).  

2. A .zip file will be generated, which you can 

either save or extract all components onto 

your computer using a program such as 

WinZip.  

Note: You will be unable to open the Excel 

file without extracting the other components 

Saving a Report to My Folder 

If you have made modifications to a standard report 

that you would like to use again, you can save the 

edited report in the My Folder directory, which can be 

accessed through the My Folder page on the Portal. 

1. From the File menu select Save As   

2. Name your edited report 

3. In the window that appears, select My Folder 

from the Location dropdown box. 

4. You can add keywords for the search function 

and a description. 

5. Select Save 
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Deleting a Saved Report 

If you decide you no longer have use for a saved 

report you can delete it from your folder. 

1. Open a different report (not the one you 

wish to delete) 

2. From the File menu select Open 

3. In the window that appears, select My 

Folder from the Location dropdown box 

4. Press the Actions icon next to the name of the report you 

would like to delete 

5. In the dropdown that appears select delete 

You will be asked to confirm that you wish to delete this report.  

Note: You can only delete your saved reports. You cannot delete the default reports. 

 

 

Modifying Graphs 

If you would like to display different information in a graph such as the pie chart within the 

Fleet Mix, you can modify the data generating the report. 

For example, if you would like to change the Fleet Mix graph to display EPS rather than 

category: 

1. Right click the graph 

and select Assign 

Data  

2. Select EPS from the 

Hidden Data and 

drag to Segments 

3. Select OK 
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